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Remark Office OMR  

Demo Tutorial 

Analyzing Surveys 

Tutorial Overview 
Thank you for downloading a demo version of Remark Office OMR. In order to allow you to sample 

the functionality in the software, we have included this tutorial. The tutorial works with pre-supplied 

sample image files so that you can walk through the various steps of using the software. The sample 

files used in this tutorial are located in your My Documents folder in a subfolder called Remark Office 

OMR\Tutorials. This tutorial outlines how to create a form template for a basic survey form. It also 

details how to process forms, correct the output and run a report. 

Note: If you plan to use Remark Office OMR to collect data from test forms, there is a 
separate tutorial accessible from the Help menu that focuses on tests. 

Important Note: The tutorials provided with the software work with image files that are included 

when you install the Remark Office OMR demo. In reality, the software can read pages directly from a 

scanner, or import scanned image files. Even though you are importing image files, the steps you are 

taking are very similar to scanning directly in the software. If you process your own forms directly with 

a scanner, you choose the options to scan instead of read from images within the software. The 

tutorial still gives you a good overview of how the software works in order to prepare you for using 

your own forms and scanner. 

There are some basic concepts to review before you get started with the tutorial. Please note that 

there are several ways to access basic software functions. Three of the most common methods 

include: 

• Getting Started Task Pane: The task pane on the left side of each Remark Office OMR 

window can be used to access the most common functions in the software. The task pane 

automatically updates based on the functions you perform. You can show or hide the task 

pane by selecting the View menu and then clicking Task Pane. 

• Toolbar: The toolbar is the series of icons across the top of each Remark Office OMR 

window. These icons represent shortcuts for common functions within the software. Hover 

your mouse over any button to see tool tip text explaining the functionality of the button. 

• Menus: The pull-down menus have all of the functions available within the software. Many of 

these functions can also be found in the toolbar and task pane. 

It is up to you to decide how you wish to access software functions. We will work with all three 

methods to allow you an understanding of each.  

Before we begin, we need to touch briefly on some important concepts that may be new to you. Just 

take in the big picture for now; details will be built as these concepts are used in the lesson. 
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Form Template Overview 
The following concepts are important to understand when performing this tutorial. Here is a quick 

overview to help you get started: 

What is a Form Template File?   

The first thing you do in Remark Office OMR is create form templates for the forms you wish to 

process in the software. A form template file contains the information needed to instruct Remark 

Office OMR about each form. The form template conveys the location of the information on the 

pages (e.g. the bubbles the respondents will darken) and the specifics of the data you require. The 

form template defines the backend database you will use for storage of the processed data. You will 

create a form template for each form that you wish to process using the software.  

How are Form Templates Created? 

Form templates are created by scanning an unmarked copy of the form (or importing a scanned 

image) to create an equivalent image in the Remark Office OMR Template Editor. You then use the 

mouse to drag boxes (called regions) around the marks (e.g. bubbles) and other areas you want to 

have recognized on your form. These regions tell the software where each piece of information you 

want to capture is located on the page and other pertinent information about the form. They also tell 

the software what type of data you need the software to output from each area.  

You are now ready to get started with the tutorial.  

The Restaurant Evaluation Survey  
This tutorial quickly teaches you how to use the basic software functions and how to easily navigate 

the software’s user interface. You create a form template for a restaurant evaluation. This evaluation is 

a typical survey form containing several types of areas that Remark Office OMR recognizes, including 

text, a barcode, OMR bubbles and an area for gathering comments. The survey asks restaurant 

patrons to provide details about their restaurant experience. The survey evaluates several restaurant 

chains within a corporation. A survey such as this one can be scanned to produce data and 

subsequently, reports to show how each restaurant is performing. 

You will perform the following steps in this tutorial: 

• Create the Restaurant Evaluation form template 

• Process completed Restaurant Evaluation forms 

• Review and correct the data output 

• Analyze the Restaurant Evaluation data with Remark Quick Stats® 

The next page shows an image of the restaurant evaluation survey so you can get an idea of the type 

of form being used in this demonstration. The survey was created in Microsoft Word. You can also 

find a copy of this form in My Documents\Remark Office OMR\Tutorials\Demo Tutorial 2. 

 

 

 



3 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 



4 

 

Creating the Restaurant Evaluation Form Template 
The first step in this process is to create a form template outlining the areas on the form that you 

want the software to recognize. 

 

To begin setting up the Restaurant Evaluation form template 

1. If not already running, start Remark Office OMR (Start|Programs|Remark Office OMR 

Demo|Remark Office OMR Data Center). 

2. Begin a new form template. Select the File menu and then click New form template. 

Alternatively, in the left-hand panel, known as the Task Pane, select New. Any of these actions 

opens a second window containing the Remark Office OMR Template Editor.  

Tip: If you use File|New Form Template or the New link in the Task Pane, the 
Template Editor opens with the new form template window already opened for you.  

3. [Optional] If the Template Editor opens but you 

do not see the Properties – Form Template 

(New) window, select the File menu and then 

click New Form Template. Alternatively, select 

the New link in the task pane.  

The Properties – Form Template (New) window 

opens. This window is where you describe your form 

to Remark Office OMR. You will do this by entering 

basic information about your form, including the 

form template description, page size and page 

orientation.  

1. Enter Restaurant Evaluation in the Description box.  

2. Locate the Page size area where you can tell the software the size paper your form uses. Select 

US Letter from the drop-down list.  

3. Locate the Page orientation area and select Portrait. 

4. Click the Capture Image button to continue.  

The Create Page Elements window appears. The Create Page Elements window allows you to either 

acquire an image of your form from your scanner, or acquire an image of your form from an existing 

image file. Each page in a form template is created using an image of the appropriate page in your 

form. The image allows you to see the form so that you can easily teach Remark Office OMR how to 

read it.  

 

To obtain a form template image 

As previously mentioned, there are two ways to acquire an image for a form template page. Images 

can be acquired by scanning to create a new image file or by opening an existing image file. We are 

acquiring our image from a pre-scanned image file stored on your computer. 

 

1. Click the button for Read Images. 

2. Click the Browse button. The Select Image File window opens. 
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3. Select the Remark Office OMR Demo Tutorial 

2– Restaurant Evaluation Survey.tif file from 

the Tutorial folder of your Remark Office OMR 

Demo installation directory (e.g. 

Documents\Remark Office OMR\Tutorials\Demo 

Tutorial 2) and then click the Open button. 

Once an image is acquired by opening an existing 

image file, the Template Editor displays a thumbnail 

of the image for your approval. 

4. When a thumbnail image of your form appears, 

click the OK button to accept the image.  

Once the thumbnail image is accepted, the Template Editor opens the new form template where you 

can begin defining the regions. You see a tree view (item list) on the left and an image representation 

of your form on the right.   

 

To define form template regions   

The purpose behind making a form template is to tell the software where to locate the information on 

your specific form and how to understand your specific data requirements. The intent of this sample 

form is to expose you to a variety of region types. The following table lists the seven regions on the 

Restaurant Evaluation form and their corresponding region types: 

 

Area on Form Corresponding Region Type 

Evaluation Questions OMR (Multiple) 

Wait Time in Minutes OMR (Grid) 

Wait Time Expectation OMR (Multiple) 

Ranking Questions OMR (Rank) 

Comments Image 

Restaurant Chain Barcode 

Restaurant Number OCR  

 

To define the evaluation questions as an OMR region 

There are four questions on the form that ask the customer to evaluate his or her dining experience. 

All four questions share the same evaluation scale of Strongly Agree to Strongly Disagree, which 

allows them to share one set of labels on the form. This compact and logical question area can be 

captured with a single OMR region even though it contains five separate questions. Defining similar 

questions in one region saves time and effort, and is preferable. 

 

1. Highlight the Page 1 node in the tree view, if not already highlighted.  

2. Select the Page menu, click Insert and then click OMR Region After Selected Page, or click the 

OMR toolbar button. Alternatively, select the Draw Regions link in the Task Pane and then Insert 

OMR Region. 
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The mouse changes to a crosshair. 

3. Place the cursor at the top left of the bubble group, then press 

and hold the left mouse button while dragging the rectangle to 

the bottom right corner of the region, capturing all four rows and 

five columns of bubbles in the region. When creating OMR 

regions, you want to leave a small buffer space between the 

region box and the bubbles (about 1/8 inch). (Do not worry if 

your box is not perfect; you can adjust it when you finish creating 

the region.) 

4. After positioning the box, release the mouse button. The Properties - OMR Region window 

appears. The Properties - OMR Region window allows you to enter information that will define 

the OMR region and the data it produces, including:  

• Region Definition (the area containing Region name, the type of OMR region or OMR type 

and the Data type).  

• Region Layout (the area detailing how many Rows and Columns of marks are contained in 

the region and their orientation).  

• Response Choices (the Labels you want to see as your data). 

5. In the Region Definition area, enter Agreement 

in the box titled Region name. This name is used 

to identify the region in the data set.  

6. For the OMR Type, select Multiple. The Multiple 

region designation is used for typical multiple 

choice style questions.  

7. For the Data type, select Textual. This region 

contains a textual scale of agreement statements, 

so textual data is appropriate.  

8. In the Region Layout area to the right, select Row 

for Region orientation. Region orientation lets 

Remark Office OMR know how the region is 

structured on the form. For this question, each row 

represents one question. 

9. Ensure that 5 was entered in the Columns in the region box and 4 in the Rows in the region 

box. The region size lets Remark Office OMR know how many rows and columns of marks are in 

the region and the software tries to figure this out for you. 

10. Enter the appropriate Labels in Response Choices. For the Labels area, click the down arrow for 

Possible label scales and choose the scale Strongly Agree to Strongly Disagree (5) from the 

list of choices. This range represents the response choices for the bubbles in all five columns, 

moving from left to right. The entries will fill the Labels grid automatically. The Labels represent 

the response choices for each bubble, moving from top to bottom. You will notice that as you 

type Labels, or when they auto-fill, numbers will automatically fill the Values column to the right. 

While the Labels represent the actual data you will see returned from the processed forms, the 

Values represent the information Remark Office OMR uses to perform any statistical analysis (such 

as calculating means).    



7 

 

11. In the Task Pane on the left, select Question 

Properties. The next step is to enter the Question 

Text and Question Names for each of the five 

questions. 

Tip: Question Text appears on the reports 
generated in Remark Quick Stats and is useful 
when exporting to some data formats. 
Question Names can be used to enter 
individual names for every question within one 
OMR region. If the Question Names grid is left 
blank, the software uses the Region Name 
defined on the previous screen and append 
sequential numbers to the end of the name to 
differentiate the questions. Individual Question 
Names are useful if you are exporting data to 
an existing file that requires specific field names (e.g. an Access table). 

12. Enter the Question Text and Question Names for each of the four questions as shown here:  

 

Question Text:      Question Names: 

 

The food was served hot and fresh.    Hot 

The menu had a sufficient selection of items.   Selection 

The quality of the food was excellent.    Quality 

The food was tasty and flavorful.    Tasty 

 

13. Click the OK button to return to the main Template Editor window.  

You now see a green box around the Restaurant Evaluation region in the form area, identifying it as 

an OMR region. You also see that Agreement has been added to the tree view. 

 

To define Wait Time as an OMR region 

The Wait Time region needs to capture the two digits as one piece of information (e.g. 30 minutes). 

We will employ a Grid OMR region to define the bubbles on the form. A Grid OMR region outputs a 

single piece of data regardless of the number of rows and columns included in the region. This type 

of region is used for items such as dates, ID numbers, social security numbers, etc.  

The steps involved to create a Grid region are the same as you used to create the OMR region we 

have already created. However, the specific properties of the 

region change to reflect the way the region is formatted on the 

form and the way we want the software to report the data.       

1. Highlight the Agreement node in the tree view, if not 

already highlighted.  

2. Click the OMR toolbar button to insert an OMR region, and 

then draw the OMR region box around the entire group of 

bubbles.  

3. After positioning the box, release the mouse button, and the 

Properties - OMR Region window appears. 
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4. In Region Definition area, enter Wait Time in the Region name box.  

5. Select Grid for the OMR type. A grid region allows the respondent to choose several response 

bubbles to make up one single response (a time in minutes, in this case). 

6. Select Numeric for the Data type. We will be 

capturing a two-digit number.  

7. In the Region Layout area, select Column for 

the Region orientation. Each column in this 

region represents one digit of the wait time. 

8. In the Columns in region box, ensure that 2 was 

entered for the Columns in the region and 10 in 

the Rows in region box.  

9. Enter the appropriate Labels in Response 

Choices. For the Labels area, click the down 

arrow for Possible label scales and choose the 

scale 0 to 9 from the list of choices. This range 

represents the response choices for bubbles in all 

five columns, moving from top to bottom. The 

numbers will fill the Labels grid automatically. The Labels represent the actual data that will be 

returned from the processed forms when filled in by the respondent, and the Grid region will 

return all selections to make a two-digit number. 

10. Click the OK button to return to the main Template Editor window. 

You now see a green box around the Wait Time region in the form area, identifying it as an OMR 

region. You will also see that Wait Time has been added to the tree view. 

 

To define Wait Time Expectation as an OMR region 

The Wait Time Expectation region is a third OMR region designed to output the whether the 

respondent thought the wait time for a table matched his/her expectations.  

 

1. Highlight Wait Time by clicking its node in the tree view, if it is not already highlighted.  

2. Select the Region menu, click Insert and then click OMR Region After Selected Region, or click 

the OMR toolbar button. Alternatively, select the Insert OMR 

region link in the Task Pane. 

The cursor changes to a crosshair.   

3. Place the cursor just to the left of the bubble for About what I 

expected, and then press and hold the left mouse button while 

dragging the rectangle to the bottom right corner, capturing all 

three bubbles in the region. 

4. In the Region Definition area, enter Wait Time Expectation in 

the box titled Region name. 

5. For the OMR type, select Multiple.   

6. For the Data type, select Textual. This region contains textual responses, so textual is the correct 

data type.  
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7. In the Region Layout area to the right, select Column for Region orientation. For this question, 

the question’s answer choices are listed in a 

column. 

8. For Columns in the region, ensure 1 was entered 

and for Rows in the region ensure 3 was entered.  

9. For the Labels area, type the number for each 

length of stay on each of the rows: About what I 

expected, A little longer than I expected, Much 

longer than I expected, one per line. This label 

range represents the response choice for each 

bubble, moving from left to right. Again you will 

notice that as you type the Labels, numbers will 

automatically fill the Values column in the grid. 

10. Click the OK button to return to the main Template 

Editor window.   

You now see a green box around the Wait Time Expectation region in the form area, identifying it as 

an OMR region. You will also see that Wait Time Expectation has been added to the tree view.  

 

To define the ranking questions as an OMR region 

There are four questions on the form that ask respondents to rank items in the order of importance to 

them. For this type of question, we can use a Rank OMR region. The Rank OMR region type allows 

respondents to enter one ranking for each question. If they choose more than one ranking per 

question, or use the same rank more than once, Remark Office OMR marks it as an exception with the 

word DUP when processing the filled-in forms. 

 

1. Highlight the Wait Time Expectation node on the left side of your screen, if it is not already 

highlighted. 

2. Select the Region menu, click Insert and then click OMR Region After Selected Page, or click 

the OMR toolbar button. Alternatively, select the Draw Regions link in the Task Pane and then 

select Insert OMR Region. 

The mouse changes to a crosshair. 

3. Place the cursor just to the left of the first bubble for Prompt Seating, and then press and hold 

the left mouse button while dragging the rectangle to the bottom right corner, capturing all four 

rows and four columns of bubbles in the region. 

 

 

 

 

 

 

 

 

4. In the Region Definition area, enter Importance Ranking in the box titled Region name. 
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5. For the OMR type, select Rank. This OMR region type will allow respondents to enter one 

ranking per question within the region.   

6. For the Data type, select Textual. This region contains textual responses, so textual is the correct 

data type.  

7. In the Region Layout area to the right, select Column for Region orientation. For this question, 

each column represents our rankings. We want one entry for each ranking. 

8. For Columns in the region, ensure 4 was 

entered and for Rows in the region ensure 4 

was entered.  

9. For the Labels area, type the label for each 

possible response in each of the rows (without 

any punctuation, which can be problematic 

when saving to certain file types): Prompt 

seating, Friendly prompt service, Food 

quality, Price & value, one per line. This label 

range represents the questions the respondent 

will be ranking, moving from top to bottom. 

Again you will notice that as you type the Labels, 

numbers will automatically fill the Values 

column in the grid (these numbers are not part 

of the rankings; the region name will determine 

the rankings 1-4). 

10. Click the OK button to return to the main Template Editor window.   

You now see a green box around the Importance Ranking region in the form area, identifying it as 

an OMR region. You will also see that Importance Ranking has been added to the tree view.  

 

To define the Comment area as an Image region 

Areas in which you expect your respondents to use handwriting can be captured by Remark Office 

OMR as Image regions. Image regions can take a snapshot of the handwriting and store it on your 

computer as an image file, allow you to hand enter the written information into your data set using 

image assisted data entry or allow you to code the comments after viewing them on-screen. You can 

run a Response Report in Remark Quick Stats to view the data entry or snapshot information from the 

Image region. We are capturing a snapshot of the handwriting. 

 

1. Highlight the Importance Ranking node in the tree view, if not already highlighted, and then 

click the Image toolbar button to insert an Image region.    

2. Once the cursor becomes a crosshair, place the cursor at the top left of the area where you would 

expect the respondent to enter their comments. Press and hold the left mouse button while 

dragging the rectangle to the bottom right corner of the area, making sure you have selected the 

entire allotted space, including the dashed line placeholder for the comments.  

   

     Do you have additional comments: 
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3. After positioning the box, release the mouse button and the Properties – Image Region window 

appears, allowing you to define the region’s properties.  

4. Enter Comments in the Region name box. 

5. Set the Region type to Image clip. This type captures each respondent’s response as a small 

image file for storage on your computer. You can then run a report in Remark Quick Stats to 

review the comments. 

6. At the bottom of the Region Definition area, 

mark the setting for Attempt to detect the 

presence of handwriting in the region. By using 

this feature, Remark Office OMR searches for 

handwriting in the Image region area during form 

processing. If writing is found, the image clip i s 

captured, and the path to the clipped image file is 

displayed in the data grid. 

7. In the Target folder box, click the ellipsis to 

choose the Images folder of your Remark Office 

OMR installation (e.g. My Documents\Remark 

Office OMR\Images). Whenever a comment is 

found, a small image file is captured in this folder. 

8. In the Begin names with box, type Demo Tutorial Comments. When the images are captured, 

the image names begin with the text “Demo Tutorial Comments” so that you know they belong to 

this form.  

9. Set the Clip file type and Compression to the default settings of TIF and Group 4. 

10. Click the OK button to return to the main Template Editor window.  

You now see the new Comments Image region visible as a blue field on your form and that 

Comments is now listed in the tree view of your form template.  

 

To define the Restaurant Chain as a Barcode region 

The barcode in the bottom left corner of the form holds the name of the restaurant chain to which 

this survey applies. In this case, a management company could own several chains of restaurants, so 

the barcode will let us know which particular chain is being evaluated. 

 

1. Highlight the Comments node in the tree view, if not already highlighted, and then click the 

Barcode toolbar button to insert a Barcode region.    

2. Once the cursor becomes a crosshair, place the cursor at the top left of the area where the 

barcode begins. Press and hold the left mouse button while dragging the rectangle to the bottom 

right corner of the area, making sure you have selected the entire barcode, plus a little extra 

space, as barcodes can vary in length.  

      

*Joes!Restaurant* 
 

 

3. After positioning the box, release the mouse button and the Properties – Barcode Region 

window appears, allowing you to define the region’s properties.  
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4. Enter Restaurant in the Region name box. 

5. For Barcode type, choose Code 39. You may 

also click the Detect button to have the 

software try to detect the barcode type. 

6. For Barcode orientation, choose the default 

entry of horizontal (barcodes can be placed 

horizontally or vertically on forms). 

7. For Data type, choose the default setting of 

Textual. This barcode has restaurant names in 

it so textual data is appropriate. 

8. This barcode does not have multiple items 

within it, so leave the checkbox for Barcode 

Contains Multiple Items deselected. 

9. Click the OK button to return to the main 

Template Editor window.  

You now see an orange box around the barcode in the image area, identifying it as a barcode region, 

and a new node in the tree view titled Restaurant. 

 

To create the Restaurant Number OCR region 

The final area of the form to recognize is the restaurant number. Each restaurant has its own unique 

identifier, which is typewritten onto the survey. We can use OCR, optical character recognition, to 

recognize machine printed text (not handwriting, which is called ICR, or intelligent character 

recognition).  

 

1. Highlight the Restaurant node in the tree view, if not already highlighted, and then click the OCR 

toolbar button to insert an OCR region.    

2. Once the cursor becomes a crosshair, place the cursor at the 

top left of the area where the restaurant number begins. Press 

and hold the left mouse button while dragging the rectangle 

to the bottom right corner of the area, making sure you have 

selected the entire allotted space. For OCR regions, it is good 

to extend the region box a little bit past the text so that you are sure to encapsulate any text 

within the area (the lengthy may vary).  

3. After positioning the box, release the mouse button and the Properties - OCR Region window 

appears, allowing you to define the region’s properties. This window allows you to provide 

pertinent information about the OCR region.   
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4. Type Restaurant Number in the Region name box. The Region name provides a brief 

description of the region and will become the 

name for this column in your data set.   

5. Set the OCR type to Primary. Primary OCR 

works well in most cases and is the default 

setting.  

6. The following options should be set to their 

default settings: 

• Data Type is Numeric. We are collecting 

restaurant numbers, which are numeric. If 

we were to export our data once it is 

collected, the data type would be flagged 

as numeric in the output file. 

• Language is English, Middle. 

• Text orientation to Left to Right. The 

text on our form is oriented from left to 

right 

OCR Image Pre-Process Options are all unchecked.  

7. Do not mark the checkbox for Region contains more than one word. The restaurant numbers 

are all run together in sequence (e.g. 123). 

8. Click the OK button to return to the main Template Editor window.  

You now see a purple box around the text in the image area, identifying it as an OCR region, and a 

new node in the tree view titled Restaurant Number. 

 

To save the tutorial form template 

We have finished creating all of the regions in our form template and need to save the form template 

as a file we can use to process completed forms. 

 

1. Select the File menu and then click Save. Alternatively, select the Save link in the Task Pane. Make 

note of where you save the form template file (we suggest Documents\Remark Office 

OMR\Tutorials\Demo Tutorial 2).  

2. In the File name box, type Demo Tutorial 2 and then click the Save button (the. .omr extension 

will be added automatically for you). 

Note: If someone has already completed the tutorial with this file name, you may 
modify the file name.  

You have now created the Tutorial form template. Close the Template Editor by selecting the File 

menu and then clicking Exit. Alternatively, you may also simply click the X in the upper right hand 

corner of the Template Editor window. 

Processing the Completed Restaurant Evaluations 
Now that you have created the form template for the Restaurant Evaluation survey, you are ready to 

begin processing the completed forms using the supplied image files.   
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To open the Restaurant Evaluation form template 

1. If not already running, start the Remark Office OMR Data Center (Start|Programs|Remark Office 

OMR Demo|Remark Office OMR Data Center). When the Data Center opens, it will display a blank 

spreadsheet-style data grid. The Data Center offers a Task Pane on the left containing the most 

commonly requested actions.  

2. Select the File menu and then click Open Form Template.  Alternatively, select the Open Other 

Templates link in the Task Pane. You must open a form template in order to process forms. 

3. Select the Demo Tutorial 2.omr file (the file you created in the previous section of this tutorial) 

and then click the Open button. Alternatively, we have provided a sample file in 

Documents\Remark Office OMR\Tutorials\Demo Tutorial 2\Remark Office OMR Demo Tutorial 

2.omr.  

When the Demo Tutorial form template opens, its name appears on the title bar at the top of the 

screen and you see the region names you specified as your column headers in the data grid. Each 

column in the grid corresponds with one variable or question in the form template, as the column 

headers indicate. The data grid fills row by row as your completed forms are processed. Each grid row 

contains information from one processed form regardless of the number of pages the form contains. 

 

To read forms from image files 

The Read window is used to process completed forms and 

produce data. The Read window has several steps to help 

customize the reading process. This tutorial will focus on 

the basic functions. As mentioned previously, we will be 

reading pre-scanned image files.  

 

1. Select the Tools menu and then click Read. 

Alternatively, select the Read link in the Task Pane. 

2. The Office Read window appears.  

3. Select the button for Read Images. 

4. Click the Next button to continue. 

The Image Selection window appears to enable you to 

view and select the images you want to process. 

5. Navigate to the Tutorial 2 folder of your Remark 

Office OMR Demo installation (e.g. 

Documents\Remark Office OMR\Tutorials\Demo 

Tutorial 2).  

6. Navigate to the Images for Processing folder.  

7. Select the file called Remark Office OMR Demo 

Tutorial 2 – Completed Restaurant Evaluations.tif 

by either double clicking it or selecting it and clicking 

the button for Add Selected, which will move the file 

into the Image List window on the right. This multi-

page TIF file contains 10 completed surveys.  

8. Click the Next button to continue. 
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The Review Exceptions window appears. This window allows you to configure options for reviewing 

exception cases such as blank and multiple responses. We will not be using this feature in this tutorial.  

9. If the Enable Review Exceptions button is marked, click it to deselect this option. We will not be 

reviewing exceptions at this time. 

10. Click the Read button to begin reading image files. 

As each image is processed, you see a row added to the data grid. Once all the forms are processed 

you are ready to review and clean the data. 

Reviewing and Correcting the Data 
After the forms are processed, 10 rows of data are displayed in the data grid. Each row represents the 

responses collected from one of the forms. You are now ready to inspect the data for missing or 

unrecognized responses in order to prepare for either analysis or export.   

Remark Office OMR informs you of unrecognized or questionable responses by color-coding each 

appropriate data grid cell and including a short descriptive word describing the exception (e.g. 

BLANK). The software then assists you to correct exception cases or problems by allowing you to see 

what was entered on the actual form. The stored images for each processed form are available to 

show you respondents’ answer choices. 

For this tutorial, we are going to run Review Exceptions, which provides an automated way to search 

through the data for exceptions and then correct them. 

 

To run Review Exceptions 

1. Select the Tools menu and then click Review Exceptions. Alternatively, select the Review 

Exceptions link in the Task Pane. 

2. Once you access Review Exceptions, use the task pane to select the exception cases you would 

like to review: Blank responses, Multiple Responses, Recognition Errors, Image Regions, Database 

Lookup Regions, Barcode Regions, OCR Regions, Repeated Rank Responses or Required Items. 

You can also choose whether to search by rows or columns in the data grid. 

3. Click the NEXT button at the top of the data grid to start the review process.  

The Data Center searches the data for the specified exception cases. When a selected exception case 

is found, it appears in the data header bar at the top of the data grid. The bar is color coded to match 

the exception type (e.g. yellow for a BLANK response). Use this window to make changes. You can use 

the drop-down list if applicable, or type a response. Note if there is a list of answer choices defined, as 

you begin typing, Remark Office OMR will attempt to auto-fill your answer based on your possible 

answer choices.  

3. The first piece of flagged data is a blank 

response in row nine for the item called 

Selection. Press Enter or click the NEXT button 

to continue. If you look at the Image Viewer, 

you see that the respondent truly did leave this 

question blank. Therefore, no changes are 

necessary. 

4. The next exception is a multiple response in row 

nine for the item called ImportanceRanking4. 

Look at the Image Viewer to see the intended response. In this case, it looks like the respondent 
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changed his response from Price & Value to Prompt 

Seating. Select Prompt Seating from the drop-down list. 

5. Press Enter or click the NEXT button to continue. 

6. The next piece of flagged data is a multiple response in row 

ten for the item called Selection. It appears that the 

respondent changed his response from Neither Agree or 

Disagree by crossing out the original mark and filling in a 

second bubble. We will assume that Agree is the correct 

response. Select Agree from the drop-down list (or type “A” 

and watch Remark Office OMR auto-fill the response). 

7. Press the Enter key or click the NEXT button. There are no 

more exception cases in the data. 

8. When prompted, click Yes to save your changes. 

Your data is now ready to be saved and analyzed. The demo 

version of Remark Office OMR does not allow data to be saved. 

In the full version of the product, you can save your data to many file formats, including Microsoft 

SQL Server, Access and Excel, SPSS®, CSV, Oracle and others. We will continue on to analysis of the 

data. 

Analyzing the Restaurant Evaluation Data 
Remark Office OMR provides statistical analysis functionality for tabulating data from your forms. The 

Quick Survey feature is one such facility and provides you with a choice of standard reports based on 

your data.  

 

To tabulate the Restaurant Evaluation data 

1. Select the Tools menu, then click Analysis and then click Quick Survey. Alternatively, click the 

Analysis tab and then select the Quick Survey link in the Task Pane. 

The Remark Quick Stats window appears. 

2. The Condensed Item Analysis Report 

should display automatically. If it does not, 

select it from the Item Analysis Reports link 

in the Task Pane on the left. 

The Condensed Item Analysis Report shows 

several statistics for each question, such as Label, 

Total and Percent. Each table displays statistics 

for a separate question in the survey. This simple, 

straightforward report may be all that you need 

to communicate your survey’s results.  

 

To run the Comparative Item Report 

The Comparative Item Report is useful for breaking down data on specific questions on the form. The 

report shows you how specific subsets of your data responded to each question. For this tutorial, we 

can use the Restaurant Chain as the basis for the report. 
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1. In the Task Pane, select the Survey and Item Statistics link, 

and then the Comparative Item link in the list. 

2. The Question Selection - Comparative Item Report 

window appears. Use this window to select up to three items 

on which to base the report. For this tutorial, select 

Restaurant and then click the Add button to move it to the 

Selected questions window (you can also double click 

Restaurant to move it to the Selected questions window).  

3. Click the Run Report button to display the report. 

When the report displays, you see each question on the form 

listed, and then how each restaurant faired. The number of 

respondents per restaurant and means for each question are 

listed on a per restaurant basis. 

 

To run the Response Report by Item Report 

The Response Report by Item Report can be used to display the open-ended comments on the form. 

We captured each respondent’s response using an Image Clip Image region. This report displays the 

image clips that were captured any time a respondent wrote in the comments box on the form. 

 

1. In the Task Pane, select the Response Reports link, and then the Respondent by Item link in the 

list.  

2. The Question Selection - Response 

Report window appears. Use this window 

to select the items on which to base the 

report. For this tutorial, select Comments 

and then click the Add button to move it 

to the Selected questions window (you 

can also double click Comments to move 

it to the Selected questions window).  

3. Click the Run Report button to display 

the report. 

When the report displays, you see any 

comments that were captured as image clips, 

in the respondent’s handwriting. You can scroll through the pages using the navigation tools in the 

toolbar. 

There are other reports available that we encourage you to view by clicking their links in the Task 

Pane. Note that you can experiment with the report options in the Report Style pane. In the full 

version of the software, you can export the reports to several formats, including PDF, Excel, RTF and 

TIF. In addition, there is a Report Batch option that allows you to automatically filter the data on up to 

three items in your data set and then automatically generate, print and/or export the resulting 

reports. 
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Tutorial Summary  
This tutorial illustrated the basics of using the software, including:  

• Creating a form template 

o OMR regions 

o Image regions 

o Barcode regions 

o OCR regions 

• Processing forms 

• Using Review Exceptions to clean data 

• Tabulating surveys with Quick Survey 

o Condensed Item Analysis Report 

o Comparative Item Report 

o Response Report by Item Report 

 

You have completed the Remark Office OMR tutorial. We hope that this tutorial has given you an 

overview of how the software works. The full version of Remark Office OMR has many more features 

to help you grade all different kinds of tests. Please note that the demo you are using can also be 

used with your own forms. Please visit our website for more product information or to purchase: 

www.remarkosoftware.com. For a full functioning trial of the software, please contact our sales 

department. We are always happy to look at the forms you want to process and answering any 

questions you may have. 
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